CSUDH End-User Percussion CM1 Training
Basic: Contributor & Editor
Version 3.1.5
Printed on: August 19, 2013

Copyright © 2013 by CSU Dominguez Hills & Percussion Software Inc.

1

2

Contents
WELCOME TO CSUDH CM1 END-USER TRAINING! ................................................................................................................. 5
What is CM1? ...................................................................................................................................................................... 5
Why use a WCMS? .............................................................................................................................................................. 5
CM1 ELEMENTS ....................................................................................................................................................................... 6
Templates........................................................................................................................................................................ 6
Layouts ............................................................................................................................................................................ 6
Regions ............................................................................................................................................................................ 6
Widgets ........................................................................................................................................................................... 6
Assets .............................................................................................................................................................................. 6
Gadgets ........................................................................................................................................................................... 6
ROLES, WORKFLOW, & PUBLISHING ....................................................................................................................................... 7
Roles .................................................................................................................................................................................... 7
Workflow............................................................................................................................................................................. 7
THE CM1 DASHBOARD ............................................................................................................................................................ 9
The Finder ........................................................................................................................................................................... 9
Finding and Selecting Elements in the Finder ............................................................................................................... 10
Search............................................................................................................................................................................ 10
My Pages ....................................................................................................................................................................... 10
Opening Finder Elements .............................................................................................................................................. 10
Resizing Columns .......................................................................................................................................................... 10
Expanding and Collapsing the Finder ............................................................................................................................ 11
Sites ............................................................................................................................................................................... 11
Finder Item Icons .......................................................................................................................................................... 11
Moving a Page or Folder in the Finder .......................................................................................................................... 12
Assets ............................................................................................................................................................................ 12
Moving an Asset or Folder in the Finder ....................................................................................................................... 13
THE CM1 EDITOR VIEW ......................................................................................................................................................... 14
Bookmarking Pages ........................................................................................................................................................... 14
Working with Pages in Editor View ................................................................................................................................... 14
Content Tab....................................................................................................................................................................... 16
Layout Tab ......................................................................................................................................................................... 16
Selecting Regions .......................................................................................................................................................... 16
Adding Widgets to a Region .......................................................................................................................................... 17
3

Style Tab ............................................................................................................................................................................ 18
WORKING WITH PAGES......................................................................................................................................................... 19
Adding Content to a Page ................................................................................................................................................. 19
Dragging and Dropping Content on Pages .................................................................................................................... 19
Adding Content through a Widget Editor ..................................................................................................................... 20
Unpublishing/Deleting a Page........................................................................................................................................... 21
Deleting Content from a Page ........................................................................................................................................... 22
Editing Content on a Page ................................................................................................................................................. 23
Modifying Content through a Widget Editor ................................................................................................................ 23
Viewing and Editing Page Meta-data ................................................................................................................................ 26
Creating a Page Summary ............................................................................................................................................. 26
Inserting Additional Head Content or Code .................................................................................................................. 27
Creating a New Page ......................................................................................................................................................... 27
Copying a Page .................................................................................................................................................................. 28
Working with Page Revisions ............................................................................................................................................ 29
WORKING WITH FOLDERS ..................................................................................................................................................... 31
Creating a Folder ............................................................................................................................................................... 31
Folder Properties .............................................................................................................................................................. 31
EDITOR FUNCTIONS .............................................................................................................................................................. 33
Approving Items and Assets .............................................................................................................................................. 33
Approving an Item (Editor Role) ................................................................................................................................... 33
Approving Assets on a Page (Editor Role) ..................................................................................................................... 33
Publishing .......................................................................................................................................................................... 34
Publishing an Item on Demand (Editor Role) ................................................................................................................ 34
Removing an Item from a Site on Demand (Editor Role) .............................................................................................. 34
Scheduling the Publishing or Removal of an Item ........................................................................................................ 35
ADDITIONAL HELP ................................................................................................................................................................. 37

4

WELCOME TO CSUDH CM1 END-USER TRAINING!
What is CM1?
CM1 is an Enterprise Web Content Management System (WCMS) software application developed by Percussion and
used by CSUDH to manage campus websites. Staff and Faculty can use CM1 to quickly update their websites, manage
content contributors and editors, and view information and statistics about their pages.

Why use a WCMS?
Using a WCMS has many benefits:










Rapid browser based content updates. No additional software needed!
Requires less web technical knowledge. Focus on content, not code!
Creates a more consistent and friendly experience for site visitors.
Manages content creation workflow and access privileges.
Allows site content and assets to be easily organized and shared across sites.
Helps reduce outdated content and broken links.
Reinforces campus branding and messaging.
Provides site usage statistics and reporting.
Enables content versioning and audit trails.

For a short video demo, visit: http://vimeo.com/15554551
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CM1 ELEMENTS
Templates
A template is a pre-defined layout for a set of pages. A template may also include pre-defined widgets
and any pre-defined widgets may include content. When you create a page, you must specify the
template that you will use for that page. The underlying layout of the template cannot be changed
when editing the page, but adding and moving widgets on the page can modify the final layout of the
page within the boundaries established by the template.
Layouts
Layouts define the general arrangement of the contents of a template or page. A layout is a set of
rectangular regions that define the sections of a template or page. Each region can contain widgets,
but in some cases may be empty. For example, a template region may include no widgets so the user
can add the widgets they prefer to the region on pages created from that template. The set of regions
for the layout is defined by the base template.
Regions
Regions are virtual spaces in templates and pages that serve as containers for widgets. On the Layout
tab of the Page editor in CM1, region outlines are represented by blue solid and dotted lines. On
other tabs, and when viewing a preview of a page or a published page, these lines are not displayed.
Widgets
To add content to a template or page layout, you must insert the data through a widget. Widgets are
CM1 controls that enable you to include different types of data and information on your web pages
without having to write any code. For example, the image widget lets you include an image on a page,
and the breadcrumb widget automatically generates a page's path. Widgets can include an editor
with content fields and configuration properties that enable you to override default values assigned
to the widget. Most widgets have both editors and configuration properties, but some only have one or the other.
Assets
An asset (shared content) is a file that stores a piece of page content such as an image or an event description. To
display an asset's content on a page or template, you insert it into a widget. The asset content looks the same as local
content (that you enter directly onto a page or template), however assets have a different function than local content.
Assets enable you to include the same content on multiple pages or templates on your website.
Gadgets
Gadgets are small boxes of data on the Dashboard that provide you with information about your CM1 environment,
such as links to CM1 resources and lists of pages in your sites in different workflow states. Gadgets are simple to use and
cannot be modified; however, you can expand, minimize, and delete gadgets from the Dashboard, and in some cases,
you can change user settings.
This topic is outside the scope of this training. Please refer to the Advance training module or contact your site
Administrator for more info.
To learn more about the Pages By Status gadget, please see the CSUDH supplemental material or visit:
http://help.percussion.com/gadgets/gadget-reference/page-by-status-gadget/index
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ROLES, WORKFLOW, & PUBLISHING
Roles
Roles are groups that have a unique set of permissions. There are two roles relevant to this training:



Contributors - can edit or create new items (pages and assets) within their own sites.
Editors - Editors have all the permissions of Contributors. They can also review and approve items, publish and
archive content.

Workflow
Content and assets in CM1 will progress through various stages of a workflow from creation to publish. At each stage of
the workflow, Roles (Contributors or Editors) will have varying permissions to edit or approve items. The status of a
content or asset item identifies which stage of the workflow it is in. These are:
Status: Draft
A Contributor of Editor edits or creates a new item (page content or asset). It can be submitted for review.
Status: Review
Item is ready for review. Editor checks or edits content and style, and then sends the item back for edits, or approves it
for publishing it.
Status: Approved (Pending & Live)
The item is now eligible to be published to the live server. (See publishing below.) It may be published, or it is in the
publishing queue. When looking at item details in the Finder, you may see additional entries in Status:



Pending: The item has been approved but has not yet been published. It may have a scheduled publish date;
otherwise, it will be published during the next Full Publish cycle.
Live: Item has been published to the live site.
These Status entries reflect internal processing by CM1. Items with these status entries are in an Approved
status.

Status: Quick Edit An Approved item has been opened for editing. Edits will resubmitted to Draft status.
Status: Archive
Item has been unpublished by an Editor manually or by a scheduled unpublish date. Items can be resubmitted to
Approved status.
Important Note: This is the only way CM1 can remove an item from the live server.
The following diagram illustrates the workflow and the actions available in each Status:
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When viewing a page, you can view the current status in the Finder and in the toolbar of the Viewer:
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THE CM1 DASHBOARD
When you initially log in to CM1, the Dashboard, the default view, presents you with useful information, such as lists of
pages on sites that you are monitoring and links to CM1 resources. Specific information and links are shown in gadgets,
the small boxes of data in the graphic below.
The first time you log in to CM1, it displays the default Dashboard:

The Dashboard is unique to each user and can be arranged based on your selection of gadgets.

The Finder
The upper panel in the Dashboard is called the Finder. The Finder allows you to interact with the file structure of your
website within CM1. Use the Finder to create, edit, move, and delete assets and pages in your system as well as to
navigate to content within your website.

If you click Assets to the far left of the Finder, the columns display the assets in your system. If you click Site, the
columns display the sections and pages in your Web sites. Note: Pages are complete website pages; assets are pieces of
content that you can include on pages.
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Finding and Selecting Elements in the Finder
The Finder contains folders that store other folders and pages or assets. When you click Assets or Sites, a folder, or a
section folder, the next column opens and displays its contents. You can locate a folder or item by follow the item's
folder path in the columns. Each column contains one of the folders in the path, so you must move sequentially through
the columns, clicking the next folder in your path until you reach the item. If you click an item, the next column displays
its properties, and you cannot open additional columns. If you want to follow a different folder path, select a different
folder in any previous column and navigate through its nested folders. If you want to select a different item in the same
path, click a different item in a previous column.
Example:
As an example, we will use the graphic above, which shows a page contained within a folder in a site. You locate
an asset in the same way. A website in the Finder probably contains multiple paths of nested folders. The final
element in each path is a page. In the graphic above, the selected path is: Sites > www.samples.com (site) >
webworks (section folder) > index.jsp (page). To navigate, starting in the left most column, first click Sites. The
next column opens and displays all of the sites your system contains. www.samples.com. The next column opens
and contains all of the folders and pages the first level of the site contains. Click webworks. When the next
column opens and displays its contents, select the page index.jsp because you want to perform an action on this
page. When the page is selected, the next column opens and shows its properties. Notice that each element
selected in the path is highlighted in the Finder, and the navigation bar specifies the path followed in the
columns: /Sites/www.samples.com/webworks/index.jsp.
Search
The Finder navigation bar allows you to navigate by entering in a path to a page or asset in the system. It also serves as a
search bar. You can type in keywords and the system will return a list of matching pages and assets. Search results are
displayed in a tabular view of Finder that displays data such as the author, workflow state, last edit date, etc.
My Pages
My Pages is a list of pages you have bookmarked in Percussion. This provides you a way to rapidly access pages you are
actively working on or which you frequently edit. You can add and remove pages to My Pages from the Editor view.
Opening Finder Elements
From the Finder, you can open sites, pages, and assets for editing. You can also open pages in read-only mode.





To open a page in read-only mode, double click on it. It opens in Editor View, but cannot be edited.
To open a page for editing, open it in read-only mode and then click the [Edit] button.
To open an asset in read-only mode, double click on it. It opens in Editor View, but cannot be edited.
To open an asset for editing, open it in read-only mode and then click the [Edit] button.

Note: Users cannot open the following system folders for edit: //Asset/uploads, //Asset/uploads/images,
//Asset/uploads/files, //Asset/forms.
Resizing Columns
To expand or reduce the width of any column in the Finder, insert your cursor between two columns or at the right side
of the last column. When the cursor takes the form of a double-arrow, drag it left or right to reduce or expand the
column preceding it. Resizing columns is useful if you want to view more columns in the Finder, or if you want to be able
to see the full name of an object.
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Expanding and Collapsing the Finder
Clicking the Collapse button reduces the Finder so that only the navigation bar and action buttons across the top are
visible:
Collapsing the Finder is useful because it expands the size of the lower panel so that you have more room to work in the
Editor or one of the Admin views. Once the Finder is collapsed, clicking the Expand button expands the Finder and
reduces the lower portion of the screen. You can also drag the dotted lines between the Finder and the lower panel up
or down to change their relative sizes.
Sites
When you click Site, the Finder displays each site in your system. You can expand a site to see its sections and folders
and the pages contained within each section or folder.
Components







Configuration button - Allows you to select one of several options -- copy page, Folder Properties, Download File
(for design files), and Upload File (for design files)
Preview Button - Opens a preview of the selected page.
New Site button - Not used by Contributors or Editors
New Folder button - Creates a new folder. Cannot create a new section folder (see Section folder definition,
below).
New Page Button - Opens the New Page dialog.
Delete button - Deletes the selected element. Note: Contributors and Editors cannot delete section folders or
landing pages in the Finder.

Finder Item Icons


The Site icon represents a site. All of the sites in your system appear in the second column of the Finder.



The Folder icon represents a regular folder. You create folders to store or categorize pages and other
folders in any way that is useful to you. For example, folders are a useful container for pages that are included in
an Auto List widget. To rename a folder, double click on it. Its name becomes editable in the Finder.



The Section Folder icon represents a navigation section of the website. You cannot create or rename a
section folder in the Finder. Each Section Folder contains a landing page; when you click a Section Folder in the
Finder, the landing page appears in the next column.



The Landing Page icon represents a site's home page or a section's landing page. The home page is the page
that first opens when you enter a site's URL in a browser. A landing page is the page accessed when you click a
section link in a live website. Note: Contributors and editors cannot create a home page or a landing page in the
Finder. When you select a Section Folder, the landing page always appears in the next column. You can add and
edit the content and layout of home pages and landing pages in the Finder as you would for any other page.



The Page icon represents a page of a website. You create a page in the Finder by selecting a folder and
clicking
the new page icon to open the New Page Dialog. After you have created the page, it is located in
the selected site, section, or folder and appears selected in the next column. Its properties are listed in the
column to the right of it. Page properties - When you select any type of page (a page, a landing page, or a home
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page), the next column opens and shows the page's properties. The Finder displays the same properties for each
type of page:
o Page Link - Name used to represent the page in any system-generated links. The text can include any
characters other than a backslash (\). When you click on the text, CM1 displays a preview of the page
either in a new tab or a new browser window, depending on the browser configuration.
o Template - The name of the template the page is using.
o Status - The state of the page's wokflow cycle.
o Last Modified - The last user that modified the page and the date and time on the CM1 server that their
modifications were saved.
o Last Published - The page's last publish date. If the page has not yet been published, the Last Published
property is not shown.

Moving a Page or Folder in the Finder
In the Finder, you can move most pages and regular folders by dragging them from one folder or section folder to
another folder or section folder within the same website. There are some limitations. You cannot:






move a page or folder from one site to another.
move a page or site folder into an asset folder.
move section folders or landing pages in the Finder.
move a page into a folder or section folder that contains a page or folder with the same name (case insensitive).
move a folder into a folder or section folder that contains a page or folder with the same name (case
insensitive).

To move a page or folder, drag it from its current folder over the folder that you want to drop it into (the target folder).
If the target folder's permissions allow it to contain the page or folder, the folder becomes highlighted. If the folder is
not already expanded, it expands and displays its contents in the next column. When you drop a page or folder, the page
or folder moves from its original folder into the target folder, and the Finder refreshes to show the change.
Assets
An asset is a file that does not represent a full website page, but stores a piece of page content, such as an image or an
event. You can include assets on multiple pages on your website, so they are also referred to as shared content.





Assets for your website are stored in: Assets/CSUDH-Sites/[site name]/
Document Assets for your website are stored in: Assets/CSUDH-Sites/[site name]/docs
Image Assets for your website are stored in: Assets/CSUDH-Sites/[site name]/images
Subfolder may be created within these folders to further organize assets.

The same filename can be uploaded multiple times as an image or file asset. If you upload an asset with the same
filename more than once, a number is appended to the filename (not the extension). The number increases by 1 each
time you upload the same filename again.
For example if an image asset named graphic.jpg, is stored as: Assets/MySite/images/graphic.jpg
If you upload an image with the same filename, it is stored as: Assets/MySite/images/graphic(1).jpg
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Note: Please remember to always follow the University File Naming guidelines posted at:
http://csudh.edu/webcomm/policies-practices/best-practices/naming-conventions/filenames.shtml
Components





New Folder button - Creates a new folder.
New asset button - Opens the New Asset dialog.
Delete button - Deletes the selected object.
Properties of Selected Asset - When you select an asset, the next column opens and shows the asset's
properties. The Finder displays the following asset properties:
o Asset - Asset name. When you click on the text, CM1 displays a read-only view of the asset editor either
in a new tab or a new browser window, depending on the browser configuration.
o Type - Asset type.
o Status - State in asset's workflow.
o Last Modified - The last user that modified the asset and the date and time that their modifications
were saved.
o Last Published - The asset's last publish date. If the asset has not yet been published, or is not
publishable, no date is shown.

Moving an Asset or Folder in the Finder
To move an asset or folder in the Finder, drag the asset or folder from a folder and drop it onto another folder. Some
types of moves are not permitted. You cannot:




move an asset or an asset folder into a site or a site folder.
move an asset into a folder that contains an asset or folder with the same name (case insensitive).
move a folder into a folder that contains an asset or folder with the same name (case insensitive).

To move an asset or folder, select it in its current folder and drag it over the folder that you want to drop it into (the
target folder). If the target folder's permissions allow it to contain the asset or folder, the folder becomes highlighted,
and if it is not already expanded, it expands and displays its contents in the next column. When you drop an asset or
folder, it moves from its original folder into its target folder, and the Finder refreshes to show the change.
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THE CM1 EDITOR VIEW
Use Editor view to create or edit items.
When you create a new page or a new asset in the Finder, the editor or form for the new item automatically opens in
Editor view.
To access Editor view to edit items double-click an asset or page in the Finder. The item opens in its form or editor in
Editor view.

Bookmarking Pages
When viewing pages in Editor view, you have the ability to bookmark page by adding them to "My Pages". To do this,
click on the star icon
to the far right of the Content, Layout, and Style tabs. You can remove a bookmark by clicking
the star on any page that has been bookmarked. Any page that has been "starred" will appear in My Pages in the Finder.

Working with Pages in Editor View
Editor view displays pages and assets differently.
When you first open a page, Editor view displays it in the Content tab in read-only mode. The page has three tabs,
Content, Layout, and Style, but the Layout and Style tabs are disabled. None of the outlines or markers for editing pages
are visible. The buttons [Close] and [Edit] appear in the upper right corner. You can click [Close] to close the page or
[Edit] to open the page for editing.

A different template for the page can be selected under Actions > Change Template.
To edit the page, click the [Edit] button. Now, the page appears in edit mode. (Note: A popup informs you if you do not
have edit permission for the page). If you have the required permission, the Content, Layout, and Style tabs are all
visible. Links to other pages in the content are enabled, and edit markers and controls are visible. The button [Close] and
a few workflow buttons appear in the upper right corner. You can click [Close] to close the page and save any edits you
have made, or click one of the workflow buttons to put the page in another workflow state.
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Important Note: Always remember to click [Close] when you’re done working with an item. This will “check in” the item
and allow it to be edited by others. Otherwise, the status of the item will remain as “checked out” by you and
unavailable to others. The following message will be displayed:

Note: On all three tabs views, when you hover your cursor over content, a tooltip appears. If the content in the page is a
shared asset, the tooltip displays its path in the asset node; otherwise, the tooltip indicates that the content is local.
In the following example, the tooltip shows the asset path:

In the following example, the tooltip indicates that content is local:
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Buttons in the upper right corner of the Content tab enable
you to close the page and move it into different workflow
states. The actions available on the workflow buttons depend
on your Role and the current workflow state of the page.
For more info about working with pages in Editor view, see
section: Working with Pages.

Content Tab
When you are in edit mode on the Content tab, you can add
content and edit content in widgets that are located on the page. You can also delete widgets from the page. When you
click a widget, an edit button
and a delete button
appear in the upper right corner of the widget. If you have
permission to edit and delete this widget, the buttons are enabled. If the widget is not editable, or if you do not have
access to either of these functions, the button for the function is grayed out. If the widget's content was added in the
template, a lock icon

appears on the widget instead of the edit and delete buttons.

Click the edit button
to open the widget editor to add or modify content. Click the delete button
content from the widget.

to delete the

Note that if the content in the widget is an asset, the editor indicates this to you by showing an edit button that appears
as

instead of

.

In the upper left corner of the tab are Meta-data, Revisions, and Preview links.

When you are in read-only mode, you can view the meta-data information. When you are in edit mode, you can edit the
meta-data information. Click the Meta-data link to open a dialog that allows you to view or change the page's metadata.
Click to open a list of revisions for the page.
When a page is opened in edit mode, you see region outlines and markers for unfilled widgets, and links are disabled.
Links are also disabled when you see a page in read-only mode. Click Preview in either mode to see how the content that
you have added will appear on a page and to access functioning links.

Layout Tab
Use the Layout tab if you work with page layout. On the Layout tab you can add and delete widgets from the page to
change the type of content that can appear on different parts of the page. Note that you must go to the Content tab to
add content; you cannot add content on the Layout tab.
Selecting Regions
Click the toggle button [+ / -] next to Explore Regions to open or close the Explore Regions list, an alphabetical list of the
names of the regions in your page. Click any of the regions in the list to select the region simultaneously in the Explore
Regions list and the page layout.
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Adding Widgets to a Region
Click the toggle button [+ / -] next to Add Widget to open or close the widget library. To add a widget to a region, drag
and drop the Widget from the list into the region.

When you click a widget, a configuration button
and a delete button
appear in the upper right corner of the
widget. If you have permission to configure and delete this widget, the buttons are enabled, as in the following graphic.
If the widget does not have configuration properties, or if you do not have access to either of these functions, the
button for the function is grayed out. If you see a lock icon
instead of
template, and you cannot configure it or delete it from the Layout tab.

17

and

, the widget is located on the page's

Click
to open a dialog of configuration properties for the widget. These properties are different for each widget. For
example, you can configure the date format of an Event widget and the maximum length of a page autolist widget.
Click

to delete the widget from its region. You can add another widget to the region from the widget library.

The [Cancel] and [Save] buttons also appear in the upper right corner of the Layout tab. Click [Cancel] to cancel any
changes that you have made to the page on the Layout tab. Click [Save] to save the changes you have made. If you
attempt to switch to another screen without clicking [Save], CM1 warns you that if you continue without saving, you will
lose your changes.

Style Tab
Click the Style tab to access properties that enable you to change the look and feel of a widget on a page.
If the widget displays a lock icon
instead of the configuration icon , you cannot access the style properties. Adding
widget style properties will require entering preconfigured CSS class identifiers. Please contact Web Communications for
the latest list of approved CSS class identifiers.
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WORKING WITH PAGES
The pages you create and design in CM1 can be published to your website. When you create a page, you select a layout
to apply and then you add content to regions within the layout. The finished page represents an actual website page but
it does not appear in your website until it is approved and published.
When you save a page, it appears in a folder that you have chosen in the Sites view of the Finder. A folder with the same
name will store it on your website, and the page's position in the site structure of the Finder will be the same as its
hierarchical position in your website.

Adding Content to a Page
You can add both assets (shared content) and local content to pages. When you add content to a page, you are actually
adding the content to a widget in a region on the page.
To add content to a page:
1. Open the page for edit
OR
Create a new page (when you save it, it automatically opens for edit).
2. If the page does not already contain the widget you want to fill with content, add the widget to it.
3. Before you add content to the widget, make any changes to its default configuration properties. Configuration
properties generally specify information regarding the appearance of a widget, such as whether an image is
rendered in full size or as a thumbnail, or the maximum number of items that can appear in an autolist. You
configure a widget when you place it on a page.
4. Click the Content tab.
5. Either:
o Add content through the widget editor, or
o Drag and drop an asset on the widget to add content.
Dragging and Dropping Content on Pages
In most cases, after a widget is added to a page, you can add content to it by dragging and dropping an asset (shared
content) onto the widget. In general, widgets permit the corresponding asset types to be dropped on them. Some
widgets do not include user-added content and you cannot drag and drop assets on them.
To drag and drop an asset onto a widget:
1. Select Assets in the Finder, and locate the asset that you want to drop onto the widget.
2. Drag the asset over the widget.
If the asset can be dropped on the widget, the widget becomes highlighted:
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If the widget is locked, disabled, or cannot contain the asset type, the widget displays a no drop icon:

3. Drop the asset onto the widget.
o If the widget accepts the asset, and the widget was empty, the widget now contains the asset and
displays its content.
o If the widget accepts the asset, and the widget already contained other content:
 If the widget can only contain one asset, it replaces the original content with the new content.
 If the widget can contain more than one asset, it appends the asset's content to the existing
content in the widget.
Adding Content through a Widget Editor
To add content through a widget editor:
1. Click the edit button on the widget.
The widget editor opens. In most cases it has the same format as the graphic below and only creates local
content, but in some cases it looks or behaves differently.
The following graphic shows the Rich Text widget editor. Some widget editors include a Meta-data section,
which is collapsed when the widget editor opens. To edit the meta-data, you can expand the Meta-data header.
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On a page, a
widget can contain content and have a lock icon
on it. The lock icon indicates that the page inherited the
widget and its content from the template. The content cannot be edited on the page. If you do not have
permission to edit a widget, a dialog pops up and warns you when you attempt to edit it.
2. Enter content in the content fields.
3. If there is a Meta-data section, expand it to view and edit its fields.
4. Click [Save].
If any of the data you have entered is invalid, a message describing the cause of the error appears on the dialog,
and you must correct the error before you can save the content.

Unpublishing/Deleting a Page
Important Note: Before deleting a page, it is best practice to use the "Remove from Site" option under Publishing on the
Content tab (Editors only). This will archive the page and queue it for removal from the live site during the next
publishing run. By archiving the page, you will be able to maintain the revision history. If you would rather remove the
page completely from CM1 and the live site, be sure to archive the page prior to deleting the page within CM1. If you
delete the page without archiving, the page will remain on the live site.
To unpublish a page that has already been published to the live server:
1. You must be a site Editor. If you are a Contributor, please contact your site Editor or Administrator.
2. Open Websites view in the Finder.
3. Locate the page that you want to unpublish and double-click it to open it in Editor view.
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4. Click [Edit] then select Publishing > Remove from Site
To delete a page in the Finder:
You can select a page in Websites view of the Finder and click the Delete Button

to delete it.

Note that you can use this procedure to delete all page types except landing pages; if you select a landing page, the
Delete Button does not become enabled. To delete landing pages, please contact your site Administrator.
When you delete a page, CM1 automatically removes links to the page on pages in Website view, but the links remain
on the published site until the next publication.
To delete a page:
1. Open Websites view in the Finder.
2. Locate the page that you want to delete and select it.
The delete icon

in the Finder's toolbar becomes enabled.

3. In the toolbar, click the Delete Button
.
4. You are prompted to confirm the action.
5. Click [Cancel] to cancel the delete action. Click [OK] to permanently delete the page.
When the page is deleted, assets on the page (shared content) remain in the Finder's Library view, but local
content on the page (content entered directly onto the page) is deleted.
Notes:





Deleting a page removes links to that page in other pages in the site. The links are not removed from published
pages until the next full publishing run executes.
If you attempt to delete a page that is open for editing by another user, a dialog informs you that it must be
closed first. Ask the user editing the page or an administrator to check in the page. Once it is checked in, you can
delete it.
If a page is open for editing by you, and you click Delete Button, the page is deleted. If you are editing the page
in a content editor, the content editor is cleared.

Deleting Content from a Page
When you remove an asset (shared content) from a page, you take it off the specific page, but it remains on other pages,
and it is still available to you. When you delete local content from a page, you permanently purge it from the system as
well as from the page.


When you delete or remove content from a page, it is deleted or removed from that page only.

You cannot delete or remove content from a widget on a page if:



The content was inherited from the template associated with the page.
The page is in a workflow state that you do not have access to.
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To delete or remove content from a page:
1. Open the page for edit.
2. Click the Content tab.
3. Click the widget from which you want to delete or remove the content.
4. Click the Delete Button
on the widget.
(If there is not any content in the widget, the button is disabled.)
o If the content in the widget is local content:
The content is deleted from the widget, and the widget is now empty. The content is permanently
deleted from the system.
o If the content in the widget is shared content (an asset):
The content is removed from the widget, and the widget is now empty. The content is still available, and
you can access it in the Finder.
Note: To delete an asset, you must delete it from the Finder. If you delete a page the local content on the page is also
deleted.

Editing Content on a Page
You can modify the content in widgets on any page that you have access to. You cannot modify a page if it is locked or
cannot be edited, or if you do not have permission to edit it; for more information, see Section: Adding Content through
a Widget Editor.
To edit content on a page:
1. Open the page for edit.
2. Click the Content tab.
3. Either:
 Modify the content through the widget editor, or
 Drag and drop an asset onto the existing content.
Modifying Content through a Widget Editor
You can edit a widget's content through its widget editor if it displays an enabled Edit Button

or Edit Asset Button

icon. The Edit Button icon
indicates that the widget contains local content. The Edit Asset Button icon
indicates that the widget contains an asset (shared content).
The following graphic shows the editor for a widget containing local content:
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The next graphic shows the editor for a widget containing an asset (shared content). The editor for an asset includes a
Folder path Meta-data field to show you the asset's location in the root asset node. (If you open the asset from the
Finder, the Folder path field does not appear, but a required Name field is present. See Creating an Asset From the
Finder for more information about the Name field.)
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If a widget has a lock icon on it, it is unavailable for edit. The lock indicates that the widget has inherited content
from the associated template.
If a widget has a disabled pencil icon, you cannot edit it. The disabled pencil icon indicates that the widget
cannot contain user-added content (such as the Navigation widget).
If a widget is in a workflow state that you do not have access to, when you attempt to edit it, a dialog warns you
that you do not have edit permission.

To modify content through a widget editor:
1.
2.
3.
4.

Click Edit Button
or Edit Asset Button
to open the widget for edit.
Modify content in any of the editable content fields.
If the widget has a Metadata section, expand it to view and edit its fields.
Click [Save].
o If any of the data you have entered is invalid, a message describing the cause of the error appears on the
editor, and you must correct the error before you can save the changes.
o If all of the data you have entered is valid, CM1 saves the modified content on the page or template and
closes the widget editor.
o If the content that you modify is a shared asset, the content changes in every widget that includes the
asset.
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o

If your edit includes modifying or uploading a new binary file, the binary file in the existing asset
changes, but a new asset is not created. Every page or template that contains the binary asset now
displays the new binary data.

Viewing and Editing Page Meta-data
As a CM1 user you can add meta-data to your pages which CM1 uses in multiple ways. The meta-data is stored in
expandable and collapsible groups of information including Page Summary, Search Engine Optimization (SEO), Tags and
Categories, Calendar, and Additional Code. Certain fields are even auto-filled based on other metadata fields e.g. the
required Page title field under the SEO grouping is auto-filled based on the Display title.
Viewing page meta-data:
1. To view meta-data, open the page.
2. Click the Meta-data link.
3. If the page is in read-only mode, the meta-data will be displayed in read-only mode.
Editing page meta-data:
1. To edit meta-data, open the page in edit mode.
2. Click the Meta-data link and edit the fields.
Note: There are some fields which will still be in read-only mode.
Character validation:
Characters that are not valid in file names on Microsoft Windows operating systems: \ / : * ? " < > |
Characters that are not safe in URLs:




# (hash, pound, or octothorpe; used in HTML anchors);
; (semicolon; used to append jsession IDs to URLs); and
% (percent sign; used to encode or escape characters in URLs).

Creating a Page Summary
There are multiple ways to create a Page Summary, which can appear in automatically generated lists.
Option 1: Uncheck the Auto-generate summary check box below the rich text editor and enter a summary in the rich
text Page summary field in the Meta-data section.
Option 2: Use the text before the <...read more> link as the page summary. Make sure the field Auto generate page
summary is checked (default) under the meta-data. Note: If more than one rich text widget on a page has a <...read
more> link, the system uses the summary last entered or modified.
1. Open the Rich Text Editor to define the text that you want displayed as the summary
2. Click your cursor at a point in the text to indicate where the page summary will stop displaying the text.
3. In the Rich Text Editor menu, select Insert > More link to insert the <...read more> link.
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Inserting Additional Head Content or Code
This topic is outside the scope of this training. Please refer to the Advance training module or contact your site
Administrator for more info.

Creating a New Page
Once your site is created in CM1, you can add pages to it. After you create a new page, you can add content to it.
This topic only refers to regular pages.



To add a new section page (navigation section), please contact your site Administrator.
A home page is automatically included in your new site.

Access the New Page dialog from the Finder by selecting a site, section folder, folder, or page in any column and clicking
the New Page button
in the Finder toolbar. The parent folder of the new page is the selected folder or the folder
holding the selected page.
To add a page:
1. In the Finder, expand the site to where you want to add the new page, and select the folder where you want to
add the new page.
If you select the site root, a section, or a folder, the new page will be added to that container. If you select a
page, the new page will be added to the parent container of the selected page.
2. Click the New Page Button
in the toolbar.
If there is a page with unsaved changes in the Viewer, the following dialog prompts you to save or discard the
changes. Otherwise CM1 displays the New Page dialog.
3. Select the template for the page. The selection defaults to the first template in the list (Content-blank-page)
4. Enter the Display Title (Link Text). The text in this field will be used to identify the links generated automatically
by CM1. You can use any character. The Display Title (Link Text) text must be different from those of other
pages within the same folder.
5. The File Name is automatically filled with the text from the Display Title (Link Text), but spaces and underscores
are converted to dashes and automatically omitted for user convenience, and upper-case letters are converted
to lower-case letters. You can manually change the values in this field.
Important Note: Please follow the University File Naming Standard when naming files. This is posted at:
http://csudh.edu/webcomm/policies-practices/best-practices/naming-conventions/filenames.shtml
The following invalid characters are automatically omitted from the File Name:
o characters that are not valid in file names on Microsoft Windows operating systems: \ / : * ? " < > |
o characters that are not safe in URLs:
 # (hash, pound, or octothorpe; used in HTML anchors);
 ; (semicolon; used to append jsession IDs to URLs); and
 % (percent sign; used to encode or escape characters in URLs.)
6. Click [Save].
The dialog closes. The Finder displays the new page in the appropriate folder. Editor view displays the new page
opened in edit mode.
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Copying a Page
The copy page feature lets you create a new page that is similar to an existing one without starting from scratch. For
example, if all of your course description pages are similar, you can save time by copying one course page and modifying
it to have a different date or description.
CM1 enables you to copy a page, and gives the copy the same content, links, and format as the original. For practical
purposes, the name and possibly the workflow state are different. A copy of a page has the suffix -copy to distinguish it
from the original page (although you will probably change the page name once you create it). All copies of pages begin
in the Draft state, regardless of the state of the original page, so they can move through an entire workflow like other
new pages.
To copy a page:
1. In the Finder, select the page that you want to copy.
2. Once the page is selected, the Copy menu item in the upper right corner of the Finder becomes enabled. Select
it to copy the page.

3. The page is copied to the same folder as the original page. All of the original page's content and features,
including the page link text and the page title, are copied, except:
o The page name, which is the original page name with “-copy” added to the end.
o The workflow state, which is always Draft for the new page.
After the page is copied, you can modify its content and features.
Notes:




If you copy a page an additional time, CM1 adds a number to the suffix copy beginning with 2. For example, if
you copied index twice, CM1 would name the second copy “index-copy-2”.
If you copy a copy of a page, CM1 appends another copy suffix to the first copy suffix. For example, if you copied
index-copy, CM1 would name the page index-copy-copy.
You can only copy pages within your allowed site.
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Working with Page Revisions
A revision is a copy of a page that CM1 creates when you edit it. The earliest copy of a page is revision 1; each
subsequent revision is incremented by 1. You can view all of the revisions of a page when the current revision is open.
You can also restore an older revision of the page, making it the current revision.
Note: A page must move to Approved status before CM1 begins creating revisions.
To view page revisions:
1. Open the page in Editor view in either read-only mode or edit mode.
2. In the upper left corner of the page, hover your cursor over View and click the Revisions link.
CM1 opens a dialog listing each revision of the page. By default, revisions are sorted from highest to lowest, but
you can sort the list on any column except Actions. The maximum number of revisions listed per page is 10; this
is not a configurable setting.
The Actions column displays Latest for the current page, preview and restore for all other p

3. Select the revision you want to preview.
CM1 opens the revision page in a separate window or tab, depending on your browser configuration.
Local content displayed on the revision page is the local content that existed when the revision was created. An
asset (shared content) displayed on the revision page is the latest version of the asset in the system. If you have
the asset checked out and have made changes to it, the asset appears to you in the revision with your changes;
the asset appears to everyone else as the latest version of the asset.
4. Close the revision page to return to the list of revisions.
5. Either view another revision or click [Cancel] to close the revisions dialog and return to CM1's Editor view.
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To restore a page revision:
1. Follow the steps for viewing revisions to open the list of revisions in either read-only or edit mode.
2. Click the restore revision icon
in the row of the revision that you want to restore.
A popup informs you if you do not have permission to restore the page. Otherwise, the revision becomes the
current version of the page opened in edit mode and the list of revisions dialog closes
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WORKING WITH FOLDERS
Folders can be added to both the Asset Library and to Sites. In the Asset Library, folders can contain any asset. In a Site,
folders can only contain pages. When you publish the site, a directory will be created corresponding to each folder
defined in the site, but the folders do not appear in the site navigation.

Creating a Folder
Folders can be created directly in your site folder, both under Sites and Assets. Folders cannot be created under the Sites
icon in the Finder, but can be created under your individual site, either directly, or under any section or folder.
To create a folder, click the New Folder icon



. The new folder is added to the Finder:

If you have an asset or a page selected, the folder is created as a sibling of the selected item (in other words,
within the current folder or section).
If you have a folder or a section or site selected, the folder is created as a child of the selected item (in other
words, within the selected folder, section, or site). Note that you cannot create a folder in the Sites node.

When a folder is created, it is assigned the default name "New-Folder", but the name of the folder in the Finder is
opened so you can edit the name. In the future, you can edit the folder name by double-clicking on the folder and
opening the Folder Properties dialog. Some characters are known to cause issues with published URLs on some systems.
To assist you in avoiding problems, we have identified a number of characters that are invalid and a few others which
are not recommended in a published URL. Invalid characters are automatically stripped from the field as they are typed
or pasted in. Characters that are not recommended are either stripped from the field or replaced by a "-" character
when initially typed in, but you can go back and retype or paste the character in if you are sure you want to use it.
Important Note: Please follow the University File Naming Standard when naming folders and files. This is posted at:
http://csudh.edu/webcomm/policies-practices/best-practices/naming-conventions/filenames.shtml
The following invalid characters are automatically omitted from the File Name:



characters that are not valid in file names on Microsoft Windows operating systems: \ / : * ? " < > |
characters that are not safe in URLs:
o # (hash, pound, or octothorpe; used in HTML anchors);
o ; (semicolon; used to append jsession IDs to URLs); and
o % (percent sign; used to encode or escape characters in URLs.)

Folder Properties
Folder properties include the permission associated with the folder, and one or more forms of its name. Folder
properties differ slightly for regular folders, section folders, and sites.
Three folder permissions are available for regular folders:




Read
Write
Admin

Note: Users do not have access to the following system folders; therefore their properties cannot be changed.
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//Asset/uploads
//Asset/uploads/images
//Asset/uploads/files

Changing a Folder’s Properties:
To change a regular folder's properties, double-click on it in the Finder. The Folder Properties dialog opens:

Folder Properties dialog fields:
Name - The folder's name. You can change the name to almost any value; however:



You cannot use one of the invalid characters listed under Creating a Folder, above. If you use an invalid
character, CM1 omits the character from the Name.
You cannot use the same name as another folder or object in the same path as the folder. If you use a duplicate
name, CM1 displays an error message, and you must change the name in order to save it.

Permission - When you first create a regular folder, all users have Admin access to it, but you (or another user) can
change the Permission from Admin to Write or Read by clicking one of the options in this field. Users in the Admin role
maintain Admin privileges to the folder. Users in other roles now have the privileges of the selected permission.
Note: If permission of a folder is changed to Read or Write, Contributor and Editors will lose the ability to manage the
folder (change name/permissions, delete, or move the folder).
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EDITOR FUNCTIONS
Approving Items and Assets
Approving an Item (Editor Role)
When you open a page or asset for edit, the default approval action is displayed in a button on the right side of the item
toolbar. If the button displays a down arrow, another approval action is available. To see this additional action, hover
the mouse cursor over the arrow. To approve an item, click on the approval action you want to use.

In the example illustration above, to approve the item, click the [Approve] button. CM1 publishes the item the next time
a Full Publish cycle is run. To reject the item (sending it back to draft), hover over the arrow on the button and click on
Reject.
Note: It is also possible to approve pages in bulk from the Pages by Status gadget on the Dashboard. The Pages by
Status gadget respects and enforces the workflow process, so if a user attempts to approve pages that should not be
approved, the user will be provided a warning message explaining why the page(s) were not approved.
Approving Assets on a Page (Editor Role)
You can approve assets independent of pages, but if an asset is included on a page, it may be approved along with the
page. For example:



If both the asset and the page are in Draft or Review status, and you approve the page for publishing, the asset
moves to Approved status along with the page.
If both the asset and the page are in Archive, and the page is revived, the asset is also revived.

Assets do not move jointly in all cases, however:


If the page moves to archive, the asset does not move to archive, since it may be used on other pages.
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Publishing
Once an item is Approved, it will be published during the next Full Publish cycle. Similarly, if you use the Archive
approval, the item is removed during the next Full Publish cycle. Rather than waiting for the site as a whole to be
published, you can publish or archive an item immediately. You can also schedule a date for the page to be published (or
archived) automatically.
Approved items can be published by two methods:
Publish Now (Publish on Demand)
An Editor can individually publish an item (page or asset) immediately to the live site.
Full Publish
All approved items in the Status: Pending state will be published on a set schedule or manually by I.T.
Publishing an Item on Demand (Editor Role)
Editors can publish pages on demand. Only image, file, and Flash assets (known as "resources") can be published on
demand. Other assets cannot be published on demand as they must be included on a page to be published.
When a page is published on demand, any resources on that page are published along with the page. Pages that link to
the newly-published page are not republished as part of this process, so some links to the page may not exist when it is
published.
To publish an item on demand:
1. Hover the mouse over Publishing on the item toolbar. CM1 displays the publishing menu.

2. Click Publish. CM1 moves the item to Approved and publishes the item.

Removing an Item from a Site on Demand (Editor Role)
Members of the Editor and Admin Roles can remove pages from a site on demand. Only image, file, and Flash assets
(known as "resources") can be removed on demand. When you remove a resource, it is removed from all sites.
When a page is removed on demand, resources used on the page are not removed, as they may be used on other pages.
Resources must be removed independently. Pages that link to the a page that has been removed on demand are not
republished, so links may be broken.
To remove an item on demand:
1. Hover the mouse over Publishing in the item toolbar. CM1 displays the publishing menu.
34

2. Click Remove from Site. CM1 moves the item to Archived and removes it from the site.

Scheduling the Publishing or Removal of an Item
You may schedule an item to be published on a specific date in the future rather than the next Full Publish cycle.
(Though an item must be in an Approved state at the time of publishing, you may schedule the publishing date at any
point, or status, of the Approval process.) Similarly, you may want to schedule a date to remove an item from the site
automatically. Editors can schedule items for publish and removal. To schedule an item for publishing or removal:
1. Hover over Publishing in the item toolbar. CM1 displays the publishing menu.
2. Click Schedule. CM1 displays the Schedule dialog.

3. To schedule the publish date for the item:
a. Click the Publishing Calendar Button
next to the Publish date field.
CM1 displays a calendar you can use to select the date.
b. Find the date you want to publish the item and click it. You can also enter a time to publish the item; the
time is relative to the time on the server; you cannot schedule a publish time earlier than the time on
the server. Time is selected in ten-minute increments, as the publisher runs automatically every ten
minutes. If you do not schedule a time, the item will be published the first time the publisher runs after
midnight of the specified date.
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Click the [Done] button. CM1 adds the date to the Publish date field.
4. To schedule the removal date for the item, repeat step 3 for the Removal date field.
CM1 publishes or removes the item on the dates you specified.
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ADDITIONAL HELP
For support questions, contact the I.T. WCMS Team or your site Administrator(s).
For additional information and more advanced tutorials, please visit Percussion’s Help site at:
http://help.percussion.com
Note: Not all topics listed on Percussion’s Help site are relevant to Contributor or Editor roles.
Helpful topics:





“How To” section
http://help.percussion.com/how-to/
Written Tutorials
http://help.percussion.com/how-to/written-tutorials/
Video Tutorials
http://help.percussion.com/how-to/video-tutorials/
CM1 Basics
http://help.percussion.com/how-to/cm1-basics/
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